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1. Mika on Confluence?

Confluence on yhteiséllisen median véline, jonka avulla voidaan tuottaa vuorovaikutteisia WWW-sivustoja wiki- eli ryhméatydperiaatteen mukaisesti. Kunkin
tydtilan omistaja voi maarittaa kayttajat, jotka voivat muokata joko tydtilan kaikkia sisaltja tai tyétilan omistajan maarittamia sivuja.

2. Miten jarjestelmaan kirjaudutaan?

2.1. Metropolian opiskelijat ja henkilékunta

2.1.1. Mene wikin etusivulle (https://wiki2.metropolia.fi, opetuksen ja opiskelun tyétilat) tai https://wiki.metropolia.fi (kaupalliset
projektit)

2.1.2. Metropolia Log in
2.1.3. Sydta Metropolia tunnuksesi ja salasanasi

2.2. Muiden suomalaisten ammattikorkeakoulujen ja yliopistojen edustajat


https://wiki2.metropolia.fi
https://wiki.metropolia.fi

2.1.1. Mene wikin etusivulle (https://wiki.metropolia.fi)

2.1.2. Haka-login

2.1.3. Valitse kotiorganisaatiosi

2.1.4. Sy6ta omassa organisaatiossa kayttdmasi tunnus ja salasana. Tunnus voi olla esimerkiksi muotoa kayttajatun
nus@kotiorganisaatio.fi tai etunimi.sukunimi@kotiorganisaatio.fi

3. Miten avataan/alustetaan/perustetaan oma tyotila?

3.1. Henkil6kohtainen tydtila

3.1.1 Aktivoi oma Metropolia-tunnuksesi osoitteessa http://activation.metropolia.fi, mikali et ole sit& viel& tehnyt.

3.1.2. Mene Confluencen etusivulle (http://wiki.metropolia.fi).

3.1.3. Kirjaudu sisaén Confluenceen ("Metropolia Log in", oikea ylakulma)

3.1.4. Kayttoliittyman oikeassa ylakulmassa nakyy nimesi/kuvasi, jonka oikealla puolella on nuoli. Avaa valikko viemalla kohdistin nuolen paalle.
3.1.5. Klikkaa "Personal Space".

3.1.6. Olet henkilokohtaisella Confluence-sivullasi, johon voit alkaa tuottaa siséltda "Edit Profile" -nappulasta. Kirjoita sivun otsikoksi esimerkiksi
nimesi.

® 3.1.7."Save".

3.2. Opinnon tai projektin tydtila

® 3.2.1. Aktivoi oma Metropolia-tunnuksesi osoitteessa http://activation.metropolia.fi, mikali et ole sita viela tehnyt.

® 3.2.2. Ehdota tyétilaa perustettavaksi ja ano tyétilan omistajan oikeuksia Metropolian Helpdeskista.

® 3.2.3. Odota, etta tydtilaehdotuksei saadaan kéasiteltyd. Tyotilaan johtava linkki ilmestyy Confluencen etusivulle vasemmanpuoleiseen
sarakkeeseen sen jalkeen, kun tyétila on alustettu.

4. Miten tehdaan uusi sivu?

4.1. Mene tyétilaasi

4.2. Create -> Blank Page

4.2. Kirjoita sivun otsikko ylimp&an laatikkoon (korvaa New Page -teksti otsikolla).
4.3. Sijoita sivun sisalto tydkaluvalikon alapuolella olevan nelikulmion siséaan.

4.4. Muokkaa sisalto (valiotsikot, linkit, kuvat).

4.5. Tallenna (painamalla Save) tai poista (Cancel).

5. Miten sivua muokataan?

® 5.1. Edit
® 5.2. Tee tarvittavat muutokset.
® 5.3. Save. Huom! Sivut paivittyvét 15 sekunnin viipeelld! Tieto paivityksesta ei aivan heti nay wikin etusivulla!

6. Miten tehdaan linkki?

6.1. Linkki Confluencen ulkopuoliseen sivuun

6.1.1. Kopioi sen sivun osoite, johon linkki viittaa.
6.1.2. Siirry Confluencen Edit-tilaan.

6.1.3. Maalaa linkiksi herkistettava merkkijono.
6.1.4. Valitse linkkityokalu (Link)

6.1.5. Web Link

6.1.5. Liita sivun osoite laatikkoon "Address".
6.1.6. OK.

6.2. Linkki toiseen Confluence-sivuun

6.2.1. Siirry Edit-tilaan.

6.2.2. Maalaa linkiksi herkistettava merkkijono.

6.2.3. Valitse linkkityokalu (Link)

6.2.4. Valitse Search-laatikosta sivu, johon linkki viittaa (kirjoita linkattavan sivun otsikko tai osa siitd)
6.2.5. OK.

7. Miten sivun kuvia hallitaan?

7.1. Miten sivulle lisatdan kuva?

® 7.1.1. Edit
® 7.1.2. Aseta kohdistin kohtaan, johon haluat kuvan sijoittaa.
® 7.1.3. Insert -> Image
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® 7.1.4. Valitse kuva
® 7.1.5. Insert

7.2. Miten sivulla oleva kuva poistetaan?

7.2.1. Edit

7.2.2. Oikeaklikkaa kuvan paalla
7.2.3. Poista/delete

7.2.4. Tallenna sivu

7.3. Miten sivulla oleva kuva vaihdetaan?

® 7.3.1. Poista vaihdettava kuva (ks. 7.2.)
® 7.3.2. Liita sivulle uusi kuva (ks. 7.1.)

7.4. Miten kuvan fyysista kokoa muokataan?

® 7.4.1. Edit

® 7.4.2. Klikkaa kuvan paalla

® 7.4.3. Klikkaa jokin oletusarvoista (vierekkaiset eri kokoiset nelitt) tai maarita kuvan leveys manuaalisesti pikseleina (poista
kuvatydkalun vasemmanpuoleisessa kentéssa jo valmiina oleva arvo (esimerkiksi 400pXx) ja kirjoita tilalle uusi arvo (esimerkiksi 500px).

® 7.4.4. Save

7.5. Miten kuva asemoidaan?
e 7.5.1. Edit

® 7.5.2. Klikkaa kuvan paalla
® 7.5.3. Valitse wikiohjelman tydkalurivilta Align left (asemoi sivun vasempaan reunaan), Align center (keskelle) tai Align right (oikealle).

7.6. Miten teksti saadaan kiertamaan kuvan ohi?

® 7.6.1. Edit
® 7.6.2. Klikkaa kuvan paalla
® 7.6.3. Asemoi kuva sivun oikeaan reunaan (ks. 7.5.3.)

8. Sivunmuokkauksen muita tydkaluja

8.1. Tyokalurivi

B lihavointi

| kursivointi

Paragraph mm. otsikoiden merkinta (Heading 1, Heading 2 jne.)
Table taulukko

Bullet list numeroimaton luettelo

Numbered list | numeroitu luettelo

Indent sisennys

Insert mm. kuvan, liitetiedoston ja makron lisays
Page layout Sivun asettelun muokkain

Undo Komennon peruuttaminen

8.2. Muita oleellisia

Cancel Poista.

Minor change? Confluence tiedottaa muutoksista ty6tilan muille kayttdjille. Ihan pienia muutoksia ei kannata kuuluttaa. Silloin rasti tahan.
Comment Kommentit siséllosta.

Location Sivun sijainti hakemistorakenteessa.

Unrestricted / Restrictions = Tassa voi rajoittaa jonkun tai joidenkin oikeutta lukea tai muokata sivua.

Labels Asettaa sivulle labelin, esim. language-fi (suomenkielinen sivu)



9. Sivujen poisto, siirto ja palauttaminen

9.1. Miten sivu poistetaan?
Sivun voi poistaa se, jolle tyétilan paikallinen admin on antanut Pages Remove -oikeuden.

® 9.1.1. Mene poistettavalle sivulle
® 9.1.2. Tools -> Delete

Huom! Delete-toiminto siirtda sivun ja siihen mahdollisesti kiinnitetyn liitetiedoston Confluencen roskakoriin (Trash), jonka tiedostot nakyvat mm. Googlen
hauissa mutta eivat Confluencen omalla hakukoneella. Jos sivu ja sen liitetiedostot pitaé havittaa lopullisesti, tulee tiedosto poistaa erikseen myds
Confluencen roskakorista (Browse/Space tools -> Space admin -> Trash -> Purge).

Huom! Delete-toiminto havittdd myos poistettavaan sivuun kytketyt liitetiedostot.

9.2. Miten sivu siirretdan tydtilan (space) sisélla toiseen hakemistoon?

® 9.2.1. Mene siirrettavalle sivulle
® 9.2.1. Tools -> Move
® 9.2.2. Kirjoita New parent page -kenttdan sen hakemiston nimi, jonka alle sivu siirretdan

9.3. Miten sivusta palautetaan aikaisempi versio?

9.3.1. Mene sivulle, jonka aikaisempi versio pitdé palauttaa

9.3.2. Tools -> Page history

9.3.3. Valitse palautettava versio klikkaamalla version nimea (esimerkiksi Version 33)
9.3.4. Restore this version

9.4. Miten Delete-napin avulla poistettu sivu palautetaan?
(Palautuksen pystyy tekeméaan tydtilan paikallinen admin)

® 9.4.1. Browse -> Space admin -> Trash
® 9.4.2. Valitse palautettavan sivun kohdalta Restore

10. Miten oikeuksia hallitaan?

10.1. Tyétilat ja henkilokohtaiset sivustot

Kunkin tyétilan omistaja eli paikallinen admin voi saataa tyotilansa luku- ja kirjoitusoikeuksia Permissions-sivulla, joka on polussa Browse -> Space Admin -
> Permissions

Oikeuksia saadetaan Permissions-sivulla seuraavasti:

® 10.1.1. Groups-valiotsikon alla voi tydtilaan liittaa ryhmia, esimerkiksi jonkin klusterin henkilokunnan ja opiskelijat. Kullekin ryhmalle voi maarittaa
luku- ja kirjoitusoikeuksia. Opas.

® 10.1.2. Individual users -véliotsikon alla voi ty6tilaan liittda yksittaisten henkildiden tunnuksia. Opas.

® 10.1.3. Anonymous access -valiotsikon alla voi saadella tydtilan nakyvyyttd Metropolian wikiin kirjautumattomille. Jos rasti laitetaan ruutuun
kohdassa View, nakyy ty6tila myos niille, jotka eivét ole kirjautuneet Metropolian wikiin (eli kaytanndssa Metropolian ulkopuolisille kayttajille).

10.2. Yksittaiset hakemistot ja sivut
Voit asettaa oikeuksia wikin tietylle hakemistolle tai sivulle. Tietyn hakemiston etusivulle asetettu oikeus patee myds hakemiston alahakemistoissa.

10.2.1. Mene sivulle tai sen hakemiston etusivulle, jolle haluat asettaaa oikeuksia.

10.2.2. Edit

10.2.3. Klikkaa Restrictions-sanan jalkeen tulevaa Edit-linkkia

10.2.3. Aseta oikeudet lukemiselle (Restrict viewing of this page) ja muokkaamiselle (Restrict editing of this page).

10.3. Miten Restrictions-méaaritelmat annetaan?

10.3.1. Valitse, koskeko Restrictions-maaritelmé lukemista (View) vai muokkaamista (Edit).
10.3.2. Valitse henkilét, jotka saavat View- tai Edit-oikeuden.

10.3.2.1. Choose users

10.3.2.2. Kirjoita henkilon sukunimi kenttéan Full name -> Search

10.3.2.3. Valitse henkild laittamalla rasti kayttajatunnuksen edessé olevaan laatikkoon
10.3.2.4. Select user

10.3.2.5. Save

10.4. Keskenerdisten siséaltdjen hallinta
Keskeneréisen sisallon voi kirjoittaa wikiin ja sulkea ulkopuolisilta seuraavasti:

® 10.4.1. Kirjoita sivun raakaversio siihen kohtaan hakemistoa, jossa se on tarkoitus aikanaan julkaista
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10.4.2. Klikkaa Restrictions-rivilté Edit (sivun alhaalla).
10.4.3. Valitse Restrict viewing of this page ja Me.
10.4.4. Restrict

10.4.5. Save

Viimeistelty sivu julkaistaan seuraavasti:

® 10.4.6. Mene takaisin sivun Restrictions-maaritelmiin ja poista rajoitus (Remove restriction).

10.5. Miten tehd&an tydtila, joka ndkyy Metropolian sisélla opiskelijoille ja henkildkunnalle mutta ei Metropolian
ulkopuolelle?

® 10.5.1. Browse -> Space admin -> Permissions (tai:Space tools -> Permissions)
® 10.5.2. Mene véliotsikon Groups alle .-> Edit permissions

® 10.5.3. Kirjoita Edit permissions to -kohtaan role:all:member

® 10.5.4. Save

10.6. Miten tyétilaan liitetadn Metropolian ulkopuolisia kayttajia?
® 10.6.1. Lahet& Metropolian kayttajatukeen palvelupyyntd ulkopuolisista tunnuksista. Pyyntdon kirjoitetaan tarvittavat tiedot.

® 10.6.2. Kayttajatuki lahettéad tunnukset sinulle sen jéalkeen, kun ne on tehty
® 10.6.3. Liitd tunnukset tyétilaasi Individual users -valiotsikon alle luvun 10.1. mukaisesti

11. Labelit

® 11.1. Team label

12. Makroilla ja plugineilla lisdominaisuuksia sivuille

® 12.1. Eri makroja (mm. sisdllysluettelo, RSS, Include, Calendar, Gallery, Content by label, Recently updated)
® 12.2. Gliffylla diagrammeja

13. Miten ty6tilan nimea vaihdetaan?
Tyétilan paikallinen admin eli hallitsija voi vaihtaa ty6tilan nimeé (eli sité nimed, joka nakyy Metropolian wikin etusivulla) seuraavasti:

13.1. Browse/Space tools

13.2. Space admin

13.3. Edit space details

13.4. Laatikossa "Name" voi muokata ty6tilan nime&

13.5. Laatikossa "Description” voi muokata tydtilan kuvausta (ndkyy Metropolian wikin etusivulla tyétilan otsikon alla)
13.6. Save

14. Miten tyétilalle valitaan ulkoasu
Tyétilan ulkoasua pystyy sen paikallinen admin saatamaan:

14.1. Browse/Space Login

14.2. Space admin

14.3. Themes

14.3.1. Valitse haluamasi ulkoasuteema
14.3.2. Confirm

14. Miten tyoétilasta tehdéén PDF-tiedosto?

® Tydtilan pystyy sen paikallinen hallitsija eli admin muuttamaan (esimerkiksi) tulostettavaksi PDF-tiedostoksi. Opas.

15. Tekijanoikeudet ja tietoturva

® Metropolian ulkopuolisen tahon tuottama aineisto on yleensa tekijanoikeuslainséadannélla suojattua. Ennen sellaisen aineiston lataamista wikiin
on asiasta keskusteltava paakayttajan kera: petri.silmala@metropolia.fi

16. Metropolian Confluenceen tehtyjen versiopaivitysten vaikutuksia

® v5.4,

17. Laajempia Confluence-oppaita

17.1. Suomenkielisia

® Helsingin yliopisto: Confluence-ohjeet:
http://wiki.helsinki.fi/display/support/Confluence-ohjeet
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17.2. Englanninkielisia
® Confluence User Guide:

http://confluence.atlassian.com/display/DOC/Confluence+User+Guide
® Confluence documentation: http://confluence.atlassian.com/display/CONF210/Confluence Documentation Home

18. Katso myos

® Sosiaalisen median henkildstokoulutusta Metropoliassa

Noudata naita!

Kayta makroja ja lisédosia vain silloin, kun on aivan pakko. Makro tai lisdosa saattaa wikialustan seuraavassa versiopaivityksessa muuttua Metropolian
ulkopuolisen ohjelmistovalmistajan paatoksella joko toimimattomaksi tai maksulliseksi. Jotkut makrot myds hidastavat sivun latautumista.

Ala kayta itse tehtyja CSS-sivupohjia. Tai jos kéytét, niin omalla vastuulla. Ne saattavat vaantaa sivun muotoilut epasuotuisasti wikialustan
versiopaivityksessa tai muuttaa sivun suorastaan kayttdkelvottomiksi.

Vaihda Documentation-ulkoasuteema joksikin muuksi. Browse (tai Space tools, vasemmalla alhaalla) -> Space admin -> Themes.

Varmista, ettd anonyymi kommentointi on tydtilassasi estetty. Mene oikeuksienmaarityssivulle (Browse tai Space tools -> Permissions -> Varmista,
ettd Annomyous Access -valiotsikon alla ei ole rastia (eli v:td) kohdassa Comments Add.
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